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Hardware Requirements
· Any computer capable of running MS-Windows 3.1. 
· RAM: The amount you have will determine at what resolution you will be able to display 

images, and how many image windows you will be able to have open at once. We 
recommend a minimum of eight megabytes; more is better.

· CD-ROM player and driver supporting Photo CD. If not multisession-capable, you will 
be able to access only images stored in the first session.

· Monitor and video card: The higher resolution and more colors your system can 
support, the more options you will    have for viewing images. We recommend a minimum
of    Super VGA at 256 colors.



Software Requirements
Windows 3.1



Installation
1. From the File menu in Windows' Program Manager, select Run.
2. Type a:install in the Command Line (where a: is the letter of your floppy drive; 

otherwise, change it).
3. Answer the questions as prompted. All files will be stored in a directory whose default 

name is C:\LANTERN.



Deinstallation
If for any reason you need to deinstall Magic Lantern all you need to do is delete the 
directory where you installed it (the default is C:\LANTERN), and all its files. No files have 
been written anywhere else, nor have modifications been made to WIN.INI, so this simple 
operation will remove all traces of    Magic Lantern.
First check the Magic Lantern directory and any others you are deleting to ensure that you 
are not going to lose information you want to keep!



Some Words on Memory Availability and 
Configuration
Your PC has three types of memory: conventional, extended, and virtual.    
Conventional memory is the first megabyte of all the RAM that you have installed. Of this 
first megabyte, 640 kilobytes are used as an area in which programs are started up. You will 
never have the entire 640K free, since some number of device drivers and TSRs will be 
present. It is important, however, that you fine-tune your system in order to have as close to
640K free as possible, or some programs might not even start.    
Windows uses extended memory to move large amounts of data. Windows also uses virtual 
memory, which is a swap file that is usually installed when you install Windows.
The resolution and speed at which you can load images depend on the combined amount of 
extended and virtual memory. The higher the amount of memory, the better off you'll be.    If 
you have less than eight megabytes of memory total, you cannot expect Magic Lantern to 
perform at its best, nor to load high-resolution images.



Getting Started
To start Magic Lantern from Windows, double-click on its icon in the Magic Lantern Program 
Group. The Magic Lantern window will initially be empty.
If this is the first time you're running Magic Lantern, do the following:
1. From the PhotoCD menu, select Memory, or click on the Memory button in the Toolbar 

(if the Toolbar is not visible, select Toolbar from the Window menu). The Memory dialog 
box has the following options:
· Application. The number at the right of the slider bar in the dialog box indicates the 

total available of RAM and virtual memory. Move the slider until the number in the 
Megabytes box indicates the amount of memory you wish to dedicate exclusively to 
Magic Lantern; the remaining memory will be used for Windows and any other 
programs you wish to run at the same time. 

· Poster. The number at the right of the slider bar in the dialog box indicates the 
maximum size of the image that you can load up, to the limit of 16 megabytes 
imposed by Windows. Move the slider within the bar until the number in the 
Megabytes box indicates the size of the Poster image that you desire. Remem-ber 
that the amount of time it will take to load the image is proportional to the size (in 
memory terms) of the image.

· Banding.  If    Banding is checked, the images will be loaded in chunks rather than 
continuously. This technique is slower, but allows you to work with a slower PC (386) 
with not too much memory (up to eight megabytes), or with computers that, in spite 
of being fast and having a lot of memory, do not have an optimized configuration. If, 
however, you have more than eight Megabytes of memory, we recommended that 
you uncheck Banding so that your pictures will load faster.

2. Click on OK to accept the values and close the dialog box.
3. Select Drive from the PhotoCD menu. In the dialog box select the drive letter 

corresponding to your CD-ROM drive, and click on OK.
Magic Lantern will also read the image of a Photo CD disc from hard disk, provided the 
entire file structure of the Photo-CD has been copied onto it.

If this is not the first time you're running Magic Lantern, and you have not changed the 
configuration of your PC, you can proceed directly to the next step.
3. From the PhotoCD menu, select Load PhotoCD. All the images on the CD will be loaded 

into the Thumbnails window
The number of thumbnails visible will depend on the size of the Thumbnails window. They 
will automatically rearrange when you resize the window. If Exact Size is checked in the 
Window menu, the window will always "snap to" the nearest size which will fit whole rows 
and columns of slides ¾ that is, no slides will be shown cut off by the window frame. If you 
prefer to size the window without regard to fitting the slides in exactly, uncheck Exact Size in
the Window menu.
Once a CD is loaded, the menu bar changs: more menus become available. One of the 
"slides" in the Thumbnails window is selected (outlined in red). You can click on any slide to 
select it, or use the Go to... command from the Thumbnails menu to select by number the 
slide you wish to view.



Loading an Image
Any loading operation can be cancelled at any moment either by
pressing the ESC key or clicking on the Cancel button.
Before loading an image, select the desired options from Load as... and Load Colors... 
sections of the Thumbnails menu:
To understand the Load as... options, you should know that every image on a Photo CD is 
stored in five versions, which differ only in their resolution, and therefore in the size at which
they can be displayed on a computer monitor ¾ the actual physical size of the image on 
screen will vary depending on the resolution of your monitor and video card. From smallest 
to largest, the options are:

· Load as Wallet: resolution 192 x 128 pixels
· Load as Snapshot: resolution 384 x 256 pixels
· Load as Standard: resolution 768 x 512 pixels
· Load as Large: resolution 1536 x 1024 pixels
· Load as Poster: resolution 3072 x 2048 pixels

(available only after cropping)
If you try to load a photo at a resolution which is not available for it, you will receive an error
message. (Portfolio™ discs, for example, do not contain the Large and Poster resolutions of 
their images.)
Which color options are available will depend on the video card installed in your computer. 
You can always choose to load an image with fewer colors than you actually have available.

· Load in 16 Colors
· Load in 256 Colors
· Load in Grayscale
· Load in TrueColor

To select an image to load, you can:
· Click on it in the Thumbnails window and then choose Load Current from the 

Thumbnails menu, or 
· Choose Load... from the Thumbnails menu. In the subsequent dialog box, the number of

the currently highlighted thumbnail will appear as default. Enter the number of the photo
you wish to load directly in the Photo: box, or select the number from the scroll box 
below. Click on OK to load the photo, or

· Double-click directly on the slide in the Thumbnails window.
THE AMOUNT OF TIME REQUIRED TO LOAD AN IMAGE WILL DEPEND ON THE TRANSFER RATE
OF YOUR CD-ROM DRIVE, THE SIZE OF THE IMAGE BEING LOADED, AND THE SPEED OF YOUR
PC's CPU. FOR FURTHER INFORMATION REGARDING MEMORY CONFIGURATION, REFER TO 
"SOME WORDS ABOUT MEMORY..."



Working with a Loaded Image
After you load an image, and whenever you make active the window containing an image, 
you will notice that the menu bar changes: there are three new menus.
Related Topics:

Photo Menu
Transformation Menu
Rotation Menu
Window Menu



Photo Menu
Copy

Copies the current image to the Windows clipboard.
Export

Allows you to export the photo in any of these formats: 
· Windows bitmap (.BMP)
· Encapsulated PostScript (.EPS)
· Paintbrush (.PCX)
· RIFF (.RIF)
· TIFF (.TIF)

Rights
Shows what copyrights are listed (if any) for the current photo.

Full Screen
Shows the image at its current size, displayed against a black background. Press CTRL + 

F to return to normal viewing. As a shortcut, press the right mouse button



Transformation Menu
Size and Color Options
These allow you to change the photo's size or color set. This is similar to using the Load 
settings, but saves you having to reload the image from the Thumbnails window.
Size in pixels of the image: If the resolution of your screen is less than the resolution of the 
image, not all of the image will fit on the screen. In this case the image will be centered and 
the borders trimmed off.
Any color options not supported by your video card will be grayed out.



Rotation Menu
As Stored
Rotated 90° Counterclockwise
Rotated 180°

Rotated 90° Clockwise
Mirrored Left to Right
Mirrored & Rotated 90° C.Clockwise
Mirrored & Rotated 180° 
Mirrored & Rotated 90° Clockwise



Window Menu
Close Photo/Close All Photos
When the active window contains a photo, the command is Close Photo. If the Thumbnail 
window is active, the command is Close All Photos, which will close all photo windows 
currently open, but not the Thumbnails window.
When an image is on the screen, you can resize the window that contains it. You may not 
make the window larger than the image at its current display size.
You can iconize any image by clicking on the minimize (down-pointing) arrow in the upper 
right corner of the Photo window; a central portion of the image will be shown in the icon as 
reference.



Cropping & Poster Sizing an Image
Crop allows you to select a portion of the photo to be displayed and/or exported. You cannot 
rotate or mirror a cropped image ¾ if it needs to be done, do it before cropping.
To crop an image you must first load it, in any resolution you like, so that you can access the 
Transformation menu. Then do the following:
1. From the Transformation menu choose Crop. The Crop dialog box will appear.
2. Move the cursor into the wallet-size image shown. The pointer will become a crosshair, 

and at upper left corner of the image you will see displayed the X,Y coordinates of the 
current position of the pointer on the image.

3. You are now going to draw a rectangle around the area you want to save after cropping. 
Press and hold down the mouse button. This will fix the upper corner of the cropped 
image. Drag the mouse to the lower right corner of the portion of the image you want to 
crop. Release the mouse button. A "rubber band" box shows the defined area. If you 
don't like the size or position of the box, you can simply repeat the operation.

The Crop Area box will give the absolute X, Y coordinates of the starting point and the 
relative dX, dY coordinates of the selected image portion.
Related Topics:

Poster Size



Poster Size
A whole image, in the maximum Photo CD resolution (16Base), is approximately 16 
megabytes when uncompressed. Most systems cannot handle such a large file and, given 
the CD drive transfer rate of 150 kilobytes per second, it would take over a minute and a half
just to load it. 
So, to keep poster images to a manageable size, we have imposed a limit on the portion of 
the image that can be transformed into Poster. The default limit is 5 megabytes. You'll know 
when you've gone too far because the Transformable to Poster check box will uncheck itself. 
Just make your crop box smaller until the check reappears, and you've got an image that can
(if you like) be transformed to Poster size.
Once you have defined the image portion you want to transform into Poster size, do the 
following, select Poster from the Transformation menu. (If the Poster selection is gray, it 
means you have cropped an area larger than the maximum acceptable poster size ¾ you 
weren't watching that check box.) The selected portion of the image will then be loaded at 
poster resolution.



Creating a Slide Show
You can create a self-running or prompted slide show of any or all of the images on one disc.
1. When the Thumbnails window is open and active, the Slide Show menu appears. Its 

options are to Set Up and Run a slide show.
2. Select Set Up. The Slide Show Setup dialog box appears.
When this window is active you can still access all the commands on the menu bar to page 
through the thumbnails.
· Click on the thumbnail of the image you want to insert into the slide show and press 

Insert. Its number will be added to the list immediately before the item currently 
highlighted in the scroll box. You can add an image at any point in the list.

· You can also type the number into the Slide text box, then click on the Insert button. 
Again, the number will be inserted immediately before the item currently highlighted in 
the scroll box.

· To insert all photos on the disc into the show, click on Insert All.
· To delete a slide from the show, highlight it in the scrolling list and click on Delete.
· To show the slides in random order, click on Shuffle (they will be shown according to the 

randomized order appearing in the scroll box).
· To clear the scroll box, click on Clear.
The Total Slides as well as the Total Time counters are constantly upgraded to reflect your
changes.
You may of course mix and match these commands as you like.
To set up how you want your show to appear:
· Choose Snapshot, Standard, or Large from the Size area.
· From the Slide Flip area, set the Time Out  ¾    the amount of time (in seconds) that 

each slide should be displayed. Note: If this time is shorter than the time actually 
required to load the image from disc (which can easily happen when loading Large 
images), a new slide will begin loading as soon as the old one is on screen. The total time
of the slide show listed below always reflects the number of slides in the show multiplied 
by the Time out, which will not be accurate if each photo actually takes longer to load 
than the Time out time given.

· If the Keyboard or Click box is checked, the next slide will begin loading the moment a 
key on the keyboard is pressed or the mouse button is clicked, regardless of whether the 
Time out time is up. If this option is checked and Time out is unchecked, control is 
completely manual - the program will always wait for a key or click before loading the 
next slide.
You may begin running your sideshow immediately by clicking on the Run button, or you 
may exit this dialog box (and even the program) and the current sideshow will be saved. 
You can then run it at any time by choosing Run from the Slide Show menu. This slide 
show will be saved, even if you exit the program, until it is cleared or replaced by 
another one.



Photo CD Menu
Load Photo CD
Drive
Unload
Memory
CD Info
Exit



Load Photo CD
Load a new Photo CD into memory.
Shortcuts:
· Hotkey: CTRL + C
· Keys: ALT + C, C



Drive
Identify the drive (volume letter) from which to load your Photo CD. Magic Lantern can also 
read the image of a Photo CD disc from hard disk, provided the entire file structure of the 
Photo-CD has been copied.
Shortcut 
· Keys: ALT + C, D
The Drive command changes to Unload when a Photo CD is loaded.



Unload
Clear the current Photo CD from memory.
Shortcut 
· Keys: ALT + C, U



Memory
Set the amount of memory (from a total of RAM plus virtual) that you wish to devote to 
Magic Lantern. The remaining memory must be sufficient to run Windows and any other 
applications which you need to run concurrently with Magic Lantern.
Shortcut
· Keys: ALT + C, M
Dialog Box Options
· Application. The number at the right of the slider bar in the dialog box indicates the 

total available of RAM and virtual memory. Move the slider until the number in the 
Megabytes box indicates the amount of memory you wish to dedicate exclusively to 
Magic Lantern; the remaining memory will be used for Windows and any other programs 
you wish to run at the same time. 

· Poster. The number at the right of the slider bar in the dialog box indicates the 
maximum size of the image that you can load up, to the maximum of 16 Megabytes 
imposed by Windows. Move the slider within the bar until the number in the Megabytes 
box indicates the size of the Poster image that you desire. Remember that the amount of
time it will take to load the image is proportional to the size (in memory) of the image.

· Banding. If    Banding is checked, the images will be loaded in chunks rather than 
continuously. This technique is slower, but allows you to work with a slower PC (386) with
not too much memory (up to eight megabytes), or with computers that, in spite of being 
fast and having a lot of memory, do not have an optimized configuration. If, however, 
you have more than eight Megabytes of memory, we recommended that you uncheck 
Banding so that your pictures will load faster.



CD Info
Gives the following information about the currently loaded Photo CD:
Volume Serial Number, Version Number, Creation Date, Last Modification Date, Total Images,
Total Sessions.
Shortcut
· ALT + C , I



Exit
Exit the program.
Shortcut
· ALT + C, X



Thumbnails Menu
Go to
Load Current
Load
Load as Wallet
Load as Snapshot
Load as Standard
Load as Large
Load as Poster
Load in 16 Colors
Load in 256 Colors
Load in Grayscale
Load in TrueColor



Go to
Allows you to select a thumbnail image to view in the Thumbnails window.
Shortcut
· Hotkey: CTRL + G 
· Keys: ALT + T, C



Load Current
Load the image currently selected (highlighted) in the Thumbnails window.
Shortcut 
· Hotkey: CTRL + L 
· Keys: ALT + T, C



Load
Select an image to load either by highlighting it in the scroll box or typing the number 
directly into the text box.
Shortcut
· Hotkey: CTRL + L    
· Keys: ALT + T, O



Load as Wallet
Sets the option to load the next image to be selected in wallet size. This command merely 
sets the size to load; you must subsequently choose Load or Load as to actually load the 
image.
Shortcut
· Keys: ALT + T, W



Load as Snapshot
Sets the option to load the next image to be selected in snapshot size. This command 
merely sets the size to load; you must subsequently choose Load or Load as to actually load 
the image.
Shortcut
· Keys: ALT T + P



Load as Standard
Sets the option to load the next image to be selected in standard size. This command merely
sets the size to load; you must subsequently choose Load or Load as to actually load the 
image.
Shortcut
· Keys: ALT T + S



Load as Large
Sets the option to load the next image to be selected in large size. This command merely 
sets the size to load; you must subsequently choose Load or Load as to actually load the 
image.
Shortcut
· Keys: ALT T + L



Load as Poster
Sets the option to load the next image to be selected in poster size. This command merely 
sets the size to load; you must subsequently choose Load or Load as to actually load the 
image. This option is only available after you have cropped the image to an acceptable size 
(see the Crop command).
Shortcut
· Keys: ALT T + R
Note: If you attempt to load a photo in a resolution which is not available for it, you will 
receive an error message.



Load in 16 Colors
Sets the option to load the next image to be selected in 16 colors. This command merely 
sets the color palette; you must subsequently choose Load or Load as to actually load the 
image. The color options available will depend on the video card installed in your computer.
Shortcut
· Keys: ALT T+ I



Load in 256 Colors
Sets the option to load the next image to be selected in 256 colors. This command merely 
sets the color palette; you must subsequently choose Load or Load as to actually load the 
image. The color options available will depend on the video card installed in your computer.
Shortcut
· Keys: ALT T+ 2



Load in Grayscale
Sets the option to load the next image to be selected in grayscale. This command merely 
sets the color palette; you must subsequently choose Load or Load as to actually load the 
image. The color options available will depend on the video card installed in your computer.
Shortcut
· Keys: ALT T+ Y



Load in TrueColor
Sets the option to load the next image to be selected in 16 million colors. This command 
merely sets the color palette; you must subsequently choose Load or Load as to actually 
load the image. The color options available will depend on the video card installed in your 
computer.
Shortcut
· Keys: ALT + T, T



Slide Show Menu
Setup...
Run



Setup...
Brings up the Slide Show Setup window. This window can be active at the same time as the 
main program window.
Shortcut
· Keys: ALT + S, S
Main Commands

· Insert. Inserts the image whose number appears in the small "slide" window 
immediately above the highlighted item in the scroll box.

· Insert All. Inserts all images in the disc immediately above the highlighted item in 
the scroll box.

· Delete. Deletes from the list    the image highlighted in the scroll box.
· Shuffle. Randomizes the order of the images listed in the scroll box.
· Clear. Clears all the images from the list.
· Run. The slide show begins immediately. 
· OK. Closes the window and saves the show until you are ready to run it (by choosing 

Run directly from the Slideshow menu.
· Cancel. Cancels the operation.

Slide Flip
· Total Time. Displays the total time required to make one complete run of the images

listed.
· Time Out. The amount of time (in seconds) that each slide should be displayed.
· Keyboard or Click. If checked, the next slide will begin loading when prompted by a 

key pressed on the keyboard or a click of the mouse button.
These last two options can be used together or separately. If both are checked, the next 
image will be loaded either when a key or mouse button is pressed, or when the time limit 
elapses, whichever comes first. If Time Out alone is checked, the show will run in 
completely automa-tic mode, loading a new slide when the time limit elapses. If Keyboard 
or Click alone is checked, the sideshow is completely manual and always waits for till a key 
or mouse button is pressed to load a new slide.

· Total Slides. Indicates the total number of slides presently in the show.
· Size: Snapshot, Standard, Large. Choose the size at which all slides in the show 

are to be displayed.
· Run. Runs the existing slide show. The slide show is saved (even if the program is 

exited) until another is set up to take its place.
Shortcut
· Hotkey; CTRL + R 
· Keys: ALT + S, R



Run
Runs the most recently created slide show.



Window Menu
Tile Horizontal
Tile Vertical
Cascade
Arrange Icons
Close (All) Photos
Toolbar
1, 2, 3,...
Slide Frame
Exact Size



Tile Horizontal
Size and position all open windows so that they are visible within the main program window, 
oriented horizontally.
Shortcut
· Keys: ALT + W, H



Tile Vertical
Size and position all open windows so that they are visible within the main program window, 
oriented vertically.
Shortcut
· Keys: ALT + W, V



Cascade
The standard Windows Cascade command, to position all open windows overlapping 
diagonally within the main program window. The title bar of each window remains visible, 
making it easy to select any window. 
Shortcut
· Keys: ALT + W, C



Arrange Icons
Arranges icons (directory windows that have been reduced to icons) so 
that they line up neatly and do not overlap. 
Shortcut
· Keys: ALT + W, I



Close (All) Photos
If a photo is open and in the active window, this command reads Close Photo, and allows 
you to close that window. If the Thumbnail window is active, the command reads Close All 
Photos, which will close all photos with the exception of the thumbnails.
Shortcut
· Keys ALT + W, P



Toolbar
Hides/displays the Toolbar.
Shortcut
· Keys: ALT + W, T



1, 2, 3,...
Displays a list of the currently open Photo windows. 
When you choose an open window, you make that image window active. You can have as 
many    image windows open at one time as available memory allows. A check mark appears 
in front of the document name of the active window.
Up to nine will be listed; if you have more you get a More Windows option which displays the
a dialog box which allows you to select among the available windows.
Shortcut
· Keys ALT + W,    1.2.3...



Slide Frame
Toggles the view of the thumbnail images in the Thumbnails window. When checked, the 
images are shown in grey "slide frames;" when unchecked, they are shown as slide film 
without frames.
Shortcut
· Keys: ALT + W, S



Exact Size
This option controls the behavior of the Thumbnails window. If check (set on), it forces the 
window to "snap to" the nearest exact number of rows and columns of thumbnail images as 
you resize the window, so that slides are never left half in view. If not checked, you may 
resize the window as you like.
Shortcut
· Keys: ALT + W, E



Photo Menu
Copy
Export
Rights
Full Screen



Copy
Copies the active image to the Windows clipboard.
Shortcut
· Hotkey: CTRL + INS
· Keys ALT + P, C



Export
Exports the file in one of the following formats:
Windows Bitmap (.BMP)
TIFF (.TIF)
RIFF (.RIF)
Paintbrush (.PCX)
Shortcut
· Keys ALT + P, X



Rights
Shows what copyrights are listed (if any) for the current photo.
Shortcut
· Keys ALT + P, R



Full Screen
Displays the image at its currently selected size against a black background. Strike any key 
or the right mouse button to return to normal viewing.
Shortcut
· Hotkey: CTRL + F
· Keys ALT + P, T



Transformation Menu
The Transformation Menu has three groups of options. The first allows you to change the 
resolution of the image displayed, choosing among:
Related Topics:

Wallet (192x128 pixels)
Snapshot (384x256 pixels)
Standard (768x512 pixels)
Large (1536x1024 pixels)
Poster (3072 x 2048 pixels)
16 Colors
256 Colors
Grayscale
TrueColor



Wallet (192x128 pixels)
Shortcut
· Keys ALT + T, W



Snapshot (384x256 pixels)
Shortcut
· Keys ALT + T, P



Standard (768x512 pixels)
Shortcut
· Keys ALT + T, S



Large (1536x1024 pixels)
Shortcut
· Keys ALT + T, L



Poster (3072 x 2048 pixels)
(available only after cropping)
Shortcut
· Keys ALT + T, R
Size in pixels of the image. If the resolution of your screen is less that the resolution of the 
image, not all of the image will fit on the screen. In this case the image will be centered and 
the borders trimmed off.
Note: If you attempt to load a photo in a resolution which is not available for it, you will 
receive an error message.
This second set of options allows you to change the number of colors in which to display the 
image, choosing among:



16 Colors
Shortcut
· Keys ALT + T, 1



256 Colors
Shortcut
· Keys ALT + T, 2



Grayscale
Shortcut
· Keys ALT + T, Y



TrueColor
Shortcut
· Keys ALT + T, T
Options not supported by your display card will be grayed out.



Rotation Menu
To rotate, mirror, or a combination of both. Rotation and mirroring are performed with 
respect to the image As Stored. You can choose among:
Related Topics:

As Stored
Rotated 90° Counterclockwise
Rotated 180°
Rotated 90° Clockwise
Mirrored Left to Right
Mirrored & Rotated 90° C.Clockwise
Mirrored & Rotated 180°
Mirrored & Rotated 90° Clockwise



As Stored
Shortcut
· Keys ALT + R, A



Rotated 90° Counterclockwise
Shortcut
· Keys ALT + R, 9



Rotated 180°

Shortcut
· Keys ALT + R, 1



Rotated 90° Clockwise
Shortcut
· Keys ALT + R, 0



Mirrored Left to Right
Shortcut
· Keys ALT + R, M



Mirrored & Rotated 90° C.Clockwise
Shortcut
· Keys ALT + R, 9



Mirrored & Rotated 180°

Shortcut
· Keys ALT + R, 1



Mirrored & Rotated 90° Clockwise
Shortcut
· Keys ALT + R, 0




